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Lab Overview 

 So far this semester, our lab activities have involved fixing “broken” PsychoPy 

experiment scripts by adding missing components. You’ve added stimuli components, such 

as Text, Images, and Random Dot Kinetograms (RDK); you’ve also added the response 

components Keyboard and Mouse components. These stimuli and response components are 

the most concrete elements of what the subjects (i.e., you) experience during the experiment. 

You even have experience with the more abstract elements of experimentation: By inserting 

Loops into the flow of an experiment and by loading conditions files (*.XLSX), you have 

specified the experimental manipulations to the stimuli. On the analytical end of the 

experiments, you have become proficient in running segments of R scripts, performing basic 

computations, and last week you even modified short segments of R scripts to complete the 

Lab 2 group analysis. 

 The purpose of Lab 3 is to pull these tasks together into a simple experiment where 

you build the entire PsychoPy script, collect data, then perform individual and group analyses 

by assembling the basic data analysis elements R (import, re-organize, analyze, plot). Some 

parts of the experiment are, by necessity, highly specified (e.g., some components need exact 

names). Other parts of the experiment are don’t need to be so exact, so you have some 

freedom to customize your experiment.  

 Lab 3 will recreate a classic experiment from cognitive psychology to observe the 

Stroop Effect. We will complete Lab 3 over the course of 3 weeks:  

Week 1: Define the Stroop Effect, build a script in PsychoPy to test it. 
Week 2: Collect data, build a script in R to analyze individual data, analyze 
individual data. 
Week 3: Build a script to analyze group data, analyze group data. 

By the end of this lab, you should be able to: 

• Build	
  a	
  PsychoPy	
  experiment	
  from	
  scratch	
  

• Assemble	
  R	
  script	
  components	
  to	
  analyze	
  individual	
  and	
  group	
  data	
  

• Test	
  a	
  hypothesis	
  from	
  response	
  times	
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LAB INSTRUCTIONS 

Introduction Section 

 We’ll begin by performing a brief literature search to define the Stroop Effect, such 

as what stimuli are traditionally used, and how it’s measured. We will also compare/contrast 

a couple of the major online databases (Google Scholar & Web of Knowledge), each of 

which have strengths and weaknesses, depending on the purpose of your search. Very often, 

those new to research have inefficient search strategies, such starting with individual research 

articles, which provide minimal research context. In Figure 1, I recommended a search 

strategy that organizes different type of sources by scope (general to specific):  

 

Encyclopediae 

1.1 In a web browser of your choice, find the Wikipedia entry on the Stroop Effect  
	
  

1.2 Copy-paste the Wikipedia description of the Stroop Effect: 
 
 

Review Articles 

Encyclopediae	
  

Undergraduate	
  Textbooks	
  

Handbook	
  Chapters	
  

Review	
  Articles	
  

Dissertations	
  

Meta-­‐
Analyses	
  
Research	
  
Articles	
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1.3 In a web browser of your choice, goto Google Scholar 
(https://scholar.google.com) 

1. Search	
  for:	
  “Stroop	
  Effect”	
  
2. The	
  top	
  hit	
  should	
  be:	
  	
  

 
	
  

1.4 Download a PDF of the MacLeod (1991) article. 
 

1.5 Read the first few paragraphs, STOP when you get to the Heading: “Stroop’s 
Classic Article”(~midway down the left column on page 164).  

1. What	
  was	
  the	
  phenomenon	
  that	
  was	
  so	
  interesting	
  to	
  these	
  authors?	
  
2. What	
  was	
  the	
  empirical	
  controversy?	
  
3. What	
  was	
  Stroop’s	
  contribution?	
  

Research Articles 

1.6 In a web browser of your choice, goto Web of Knowledge 
(webofknowledge.com). 

1. Using	
  the	
  search	
  fields,	
  search	
  for	
  Stroop’s	
  1935	
  article,	
  entitled	
  Studies	
  
of	
  interference	
  in	
  serial	
  verbal	
  reactions.	
  

For example: Author, Year Published 

 
1.7 Download a PDF of the Stroop (1935/1992) research article (it’s an APA 

reprint). 
 

1.8 In 1935, J. Ridley Stroop didn’t have computers to perform his experiments. 
In your own words, describe the methods in experiment 1 
 

1.9 What was the result? Shown in Table I, and in prose on page 17. 
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Method Section 

Time to make our own experiment! 

2.1 In a classic Stroop Color-Word Task, what are the independent variables? 
Independent	
  Variable	
  1:	
  
	
  
Independent	
  Variable	
  2:	
  
	
  

2.2 In a classic Stroop Color-Word Task, what is the dependent variable? 
 
 

We’ll be making a variation of the classic experiment that includes the above 

variables, and measures response time (RT) one word at a time. Let’s begin by defining the 

experimental conditions in the conditions file, appropriately named conditions.xlsx. 

2.3 Open Lab 3 Tools > Stroop exp > conditions > conditions.xlsx 
1. Note	
  the	
  header	
  names	
  -­‐	
  DO	
  NOT	
  CHANGE	
  THESE.	
  We	
  need	
  these	
  

names	
  later	
  in	
  	
  the	
  PsychoPy	
  script.	
  
	
  

text letterColor corrAns congruent 
    

 

2.4 The text column defines the text that our stimuli will be.  
1. In	
  this	
  experiment,	
  we’ll	
  use	
  the	
  words	
  red,	
  green,	
  and	
  blue.	
  

	
  
2.5 The letterColor column defines the color that our stimuli will be. 

1. Also,	
  the	
  colors	
  red,	
  green,	
  and	
  blue.	
  
2. What	
  will	
  a	
  subject	
  see	
  for	
  row	
  2?	
  Row	
  10?	
  

	
  
2.6 Subjects will respond by pressing the left, down, and right arrow keys on the 

keyboard. Here are the instructions (and correct responses): 
 
letterColor Correct Response (corrAns) 
red left 
green down 
blue right 

 

2.7 The corrAns and congruent columns are blank. Let’s fix that. 
 

2.8 In the corrAns column, add the correct response for each row of letterColor 
condition (as shown in Box 2.6).  

1. Only	
  left,	
  down,	
  or	
  right	
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2. All	
  lower	
  case,	
  no	
  extra	
  characters	
  
	
  

2.9 In the congruent column, add whether the condition is congruent or 
incongruent.  

1. If	
  the	
  word	
  AND	
  the	
  letterColor	
  are	
  the	
  same,	
  then	
  it	
  is	
  a	
  congruent	
  trial.	
  	
  
2. If	
  the	
  word	
  AND	
  the	
  letterColor	
  are	
  NOT	
  the	
  same,	
  then	
  it	
  is	
  an	
  

incongruent	
  trial.	
  
	
  

2.10 SAVE your changes. 
 
IMPORTANT: Check and recheck that your conditions.xlsx entries are 
accurate before continuing!!!! 
 

Trial Routine (must be EXACT) 
2.11 Open PsychoPy, and create a new experiment: File > New (⌘N) 

	
  
2.12 Save the experiment to Lab 3 Tools > Stroop exp as something like: Lab 3 

Stroop.psyexp 
 

2.13 In the trial routine, add 2 components: 
1. A	
  Text	
  component	
  named	
  word.	
  
2. A	
  Keyboard	
  component	
  named	
  resp.	
  
3. Save	
  &	
  Test.	
  

	
  
2.14 In the word component: 

1. We	
  want	
  the	
  word	
  to	
  show	
  up	
  half	
  a	
  second	
  after	
  the	
  start	
  of	
  the	
  
Routine,	
  and	
  not	
  disappear.	
  

2. We	
  want	
  the	
  text	
  twice	
  as	
  big.	
  
3. Save,	
  test.	
  

 
2.15 In the word component: 

1. Change	
  the	
  text	
  to	
  say	
  something	
  else	
  (classroom	
  appropriate)	
  
2. Change	
  the	
  color	
  of	
  the	
  text	
  (try	
  different	
  color	
  names)	
  
3. Try	
  out	
  different	
  combinations	
  of	
  settings	
  
4. Save,	
  test	
  

	
  
2.16 Add a Loop around the trial routine, and name it trials (probably the default) 

1. In	
  the	
  Conditions	
  field,	
  use	
  the	
  Browse	
  button	
  to	
  load	
  the	
  conditions.xlsx	
  
file	
  we	
  fixed	
  earlier.	
  

2. If	
  this	
  worked	
  properly,	
  it	
  should	
  read:	
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3. Save.	
  

	
  
2.17 Next, add the variables that tell PsychoPy what text to display ($text), and 

what color to display that text ($letterColor). In the word component 
1. Add	
  the	
  following	
  variables:	
  

a. $text	
  
b. $letterColor	
  

2. HINT:	
  Where	
  is	
  the	
  most	
  logical	
  place	
  for	
  these	
  variable	
  names?	
  
3. IMPORTANT:	
  To	
  the	
  right	
  of	
  the	
  fields	
  you	
  added	
  the	
  variables	
  ($),	
  

change	
  the	
  dropdown	
  boxes	
  to	
  “set	
  every	
  repeat”.	
  If	
  your	
  script	
  doesn’t	
  
work	
  properly	
  or	
  crashes	
  during	
  test,	
  this	
  is	
  the	
  most	
  likely	
  culprit!	
  

4. Save,	
  test.	
  

PROTIP: Once it becomes obvious to you that a change you made is working 
properly (or not), you can end the test with the “Escape” key. 

	
  
2.18 Time to adjust the settings for the Keyboard components you named resp: 

1. We	
  don’t	
  want	
  subjects	
  to	
  respond	
  before	
  they	
  see	
  the	
  text	
  stimuli.	
  
2. We	
  want	
  to	
  limit	
  subjects	
  responses	
  to	
  the	
  appropriate	
  arrow	
  keys	
  

(left,	
  down,	
  up)	
  
3. We	
  want	
  PsychoPy	
  to	
  store	
  whether	
  a	
  response	
  was	
  correct	
  or	
  not,	
  

(HINT:	
  so	
  we	
  need	
  to	
  tell	
  PsychoPy	
  what	
  the	
  correct	
  answers	
  are)	
  
4. Save,	
  test.	
  

	
  
2.19 At this point, you should probably check to see if PsychoPy is properly storing 

responses. 
1. Open	
  the	
  most	
  recent	
  CSV	
  file	
  in	
  the	
  “data”	
  folder	
  (Remember,	
  the	
  file	
  

name	
  has	
  a	
  timestamp).	
  
2. In	
  the	
  resp.corr	
  column	
  (1=correct,	
  0=incorrect)	
  

	
  

Practice Routine (must be EXACT) 
2.20 Once you are certain that the trial routine is working properly, we need to add 

a practice routine before the trial routine so subjects can get used to using the 
arrow keys to respond. 

1. Name	
  the	
  routine	
  “p_trials”,	
  and	
  its	
  Loop	
  “practice”	
  
2. The	
  practice	
  routine	
  is	
  identical	
  to	
  the	
  trial	
  routine,	
  except	
  that	
  	
  

a. The	
  text	
  and	
  keyboard	
  components	
  should	
  different	
  names	
  (e.g.,	
  
word2,	
  resp2)	
  

b. The	
  number	
  of	
  blocks=1	
  (nReps	
  in	
  the	
  Loop	
  settings).	
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3. Save,	
  test.	
  
	
  

 

So far we’ve created the core of our experiment, now we need to add routines 

that include on-screen instructions for subjects when taking the experiment. 
Each of these Routines need only 2 components: a text and a keyboard component. The text 

will show a message to the subject, and the keyboard component will advance the experiment 

by ending the routine. The names of these routines & components do not really matter, but 

give the routines names that are meaningful to you. The default component names work just 

fine. 

Instructions (can be flexible) 
2.21 Add 3 of these instructions/message routines to the experiment 

1. Add	
  a	
  routine	
  before	
  the	
  practice	
  routine	
  that	
  welcomes	
  the	
  subject	
  
and	
  tells	
  them	
  the	
  task	
  instructions.	
  

2. Add	
  a	
  routine	
  after	
  the	
  practice	
  routine	
  and	
  the	
  trial	
  routine	
  that	
  tells	
  
the	
  subject	
  that	
  the	
  real	
  experiment	
  is	
  about	
  to	
  begin.	
  

3. Add	
  a	
  routine	
  after	
  the	
  trial	
  routine	
  that	
  thanks	
  the	
  subject	
  for	
  taking	
  
your	
  experiment.	
  

a. Alternately,	
  for	
  this	
  final	
  routine,	
  you	
  could	
  omit	
  the	
  keyboard	
  
component	
  	
  and	
  set	
  a	
  duration	
  for	
  the	
  text	
  component,	
  (e.g.,	
  
4.0s)	
  which	
  would	
  automatically	
  end	
  the	
  experiment	
  after	
  a	
  few	
  
seconds.	
  

4. Save,	
  test.	
  
2.22 Change the settings of your text components until they look the way you want.  

 

ZIP & Save your work 
2.23 Once your experiment works properly and looks professional, now is the time 

to SAVE the experiment for next week1. 
1. In	
  the	
  data	
  folder,	
  delete	
  all	
  the	
  files	
  that	
  were	
  generated	
  each	
  time	
  you	
  

tested	
  your	
  script	
  (i.e.,	
  empty	
  the	
  data	
  folder).	
  
2. Your	
  experiment	
  folder	
  should	
  look	
  something	
  like	
  this:	
  

                                                
1 This will become a crucial procedure in Lab 4 to keep your experiment files organized and 
working properly!!!!1!!! 
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3. Compress	
  the	
  experiment	
  folder	
  to	
  make	
  a	
  ZIP	
  file	
  that	
  is	
  easier	
  to	
  save.	
  

a. Right-­‐click	
  the	
  folder	
  you	
  want	
  to	
  compress,	
  and	
  select	
  
Compress	
  “XXXXX”	
  

 
4. Save	
  this	
  ZIP	
  file	
  using	
  whatever	
  method	
  works	
  best	
  for	
  you	
  

(Flashdrive,	
  GoogleDrive,	
  Dropbox,	
  etc.)	
  
	
  

 

 


